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1.	 Formatting FAQs
Q:	 What specifications does the Graduate School have regarding formatting 

theses and dissertations, and where can I find them?
A:	 In addition to this PDF guide, the Graduate School summarizes all of its requirements

•	 at the thesis and dissertation Format page of the Graduate School website, and

•	 on a Final ETD checklist PDF

Also linked at Theses & Dissertations Overview is a page of Templates, Links & Tools, where 
the final checklist resides. The checklist can help you keep your formatting for each section of your 
paper consistent and on track.

Q:	 Does everyone have to use the same writing style guide?

A:	 No — the Graduate School does not require 
that you use one particular style handbook for 
your thesis or dissertation. Your department 
may recommend a recognized style manual for 
writers of academic papers, such as the MLA or 
APA style manuals. If you are unsure about what 
style is generally accepted in your field, and your 
department does not specify a style guide, consult 
your advisor and, together, choose a style that is 
suitable for your discipline.

Q:	 Where do I find content-related 
requirements?

A:	 You and your committee are responsible for your document’s quality and content. Your 
graduate program handbook may contain basic information about thesis or dissertation 
requirements. When you have questions concerning the content of your work, you should ask your 
advisor/committee chair or another committee member who is familiar with your work and the 
practices of your field.

The staff of the Manuscript Review office can help you interpret our formatting requirements, 
but your committee is the best source of advice for writing and organizing your work. While the 
Manuscript Review staff may point out noticeable inconsistencies in grammar, spelling, or usage 
for you to revise, or may catch a typo in a major heading or prominent text element, we do not check 
your manuscript word-for-word.

Q:	 Will the Manuscript Review staff proofread 
my paper?

A:	 No. As noted above, the reviewer may call your attention 
to typographical, spelling, or grammar errors in highly visible 
portions of your manuscript. Note, for instance, that the 
default setting for Word’s spellcheck tools overlooks words in 
all caps, which can sometimes lead to typos in headings, and 

Quick tip

By default, Word’s spell-checker 
overlooks words typed in ALL 
CAPS. You may want to re-check 
your ETD title and all-caps 
headings visually before you 
submit your manuscript. 

Quick tip

While Word supplies built-in templates for 
MLA- and APA-style papers, please note that 
if you use these, you should otherwise follow 
Graduate School formatting guidelines. 
Running heads as shown in the APA template 
are not preferred in your ETD unless your 
advisor requires them. The templates do 
supply useful info and appropriate text style 
menus if you’re following APA or MLA style.

https://www.clemson.edu/graduate/students/theses-and-dissertations/format.html
https://www.clemson.edu/graduate/files/pdfs/Checklist_final.pdf
https://www.clemson.edu/graduate/students/theses-and-dissertations/index.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/forms-links-tools.html
https://www.clemson.edu/graduate/academics/programs.html
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we’ll point those out if we see 
them. But we don’t read word-
for-word or critique either the 
mechanics or the content of 
your writing.

Q:	 Are there different 
requirements for 
electronic versus 
printed manuscripts?

A:	 In the print publishing 
realm, yes. However, the 
Graduate School does not 
supply guidelines for printed 
manuscripts. The guidelines 
provided by the Graduate School 
are intended for electronic 
documents, and if you submit 
a thesis or dissertation formatted according to these guidelines, your end product will be a fully 
functional, quality electronic manuscript. 
	 If you plan to purchase bound copies for yourself or your department, if required (see this list 
of departments requiring copies), and you follow these e‑publishing guidelines, your manuscript 
may not meet traditional print publishing standards. For example, the first page of each main 
section will not start on a right-hand page, and the binding margin will not be any wider than 
the outside margin — potentially causing text and/or images to be very close to, or hidden in, the 
binding. You may opt to adhere to more conventional formatting guidelines for printed manuscripts 
if you so choose, but the Manuscript Review staff will be unable to assist with formatting specifically 
for print. You should consult your advisors for additional guidance if you plan eventually to publish 
your manuscript as a bound book following academic book design norms.

Q:	 What tools are available to help me format my manuscript?

A:	 If you are using Microsoft Word, a Graduate School formatting template is available for your 
convenience. To edit and use it, you’ll need to:

•	 Save the template to your hard drive and from there, open it in Word;

•	 Make sure you re-save the template with your preferred filename, so you maintain a clean 
copy of the template.

In addition to the formatting template, the Manuscript Review 
office provides PDF examples of each standard element of an academic 
paper, and a complete sample manuscript. You will find all of these 
documents listed and linked at Templates, Links & Tools on the 
Graduate School website.

Hot link

Download the Graduate 
School Word template 
for ETDs.

Best practices

The research and writing in your thesis or dissertation must be 
your own, but to assist you with formatting, extensive typing or 
transcription, editing, and proofreading, you may legitimately 
engage assistance — professional or volunteer.
	 On the Templates, Links & Tools page, the Graduate School 
provides a Typist/Editor list. Individuals and vendors on this list 
have experience working with Clemson ETDs or similar projects, 
and have expressed interest in working with Clemson graduate 
students. The Graduate School does not endorse any particular 
freelancer or business, and cannot negotiate fees for you. You are 
also free to choose from outside this list. Always be mindful of the 
importance of academic integrity when engaging support.
	 If you do plan to work with a typist or editor, don’t forget to 
point them toward the Graduate School’s thesis and dissertation 
webpages and templates.

https://www.clemson.edu/graduate/students/theses-and-dissertations/boundcopies.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/boundcopies.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/gs_manuscript_template.docx
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/Example%20Manuscript_5-18-07_SAM-3.pdf
https://www.clemson.edu/graduate/students/theses-and-dissertations/forms-links-tools.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/gs_manuscript_template.docx
https://www.clemson.edu/graduate/students/theses-and-dissertations/forms-links-tools.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/typist_list.pdf
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2.	 General formatting guidelines — your manuscript 
as a whole

All thesis and dissertation manuscripts should be formatted according to the instructions in 
the following sections, except for content that has been previously published (for instance, in a 
journal, with elements required by that journal that don’t appear in other chapters), or unless your 
department has requested and received an exemption based on discipline-specific practices (see 
4. Additional Formatting Information below). Content not covered by these specific guidelines 
may be formatted in any accepted discipline-appropriate style.

Quick tip

If you’re using a version of 
Microsoft Word from a source 
outside the U.S., or you’ve 
recently formatted for an 
international journal, your 
default page size may be set 
to A4 rather than U.S. Letter 
Standard. We won’t send your 
manuscript back for revision 
if it’s A4 page size, as long as 
all pages are the same size. 
The Graduate School simply 
prefers U.S. Letter size.

About updates to formatting requirements, Fall 2021

If you have previously formatted a Clemson thesis or dissertation, or if you are graduate faculty, you 
may notice a few minor relaxations in the Graduate School’s formatting guidelines. You can download 
the PDF, Updates to ETD Formatting Requirements to read about these changes for the 2021–22 
academic year online.

Document page size

The Graduate School prefers that your ETD document size be U.S. Letter Standard (8.5" x 11"). 
If you have used word-processing software or a LaTeX template provided by a non-U.S. source, or 
you’ve prepared a paper for an international journal, your default 
page size may be set to A4 (8.27" x 11.69"). That’s acceptable now! 
The page size standardization was essential for print copies from 
ProQuest when they were the submission portal host, but with 
the Fall 2021 semester transition to TigerPrints ETD, we won’t 
send your manuscript back for being A4 size. If your research 
includes material that will not fit onto standard letter-sized pages; 
you may include such material as additional files. See section on 
additional files (spreadsheets, databases, movies, sound files, 
etc.) below.

Margins

•	 All page margins must be between 1 inch and 1.25 inches. 
Word’s default page margin setting is 1" on all sides. 
Historically, the Graduate School has required 1.25" margins 
to accommodate print binding. With the move to all-online 
publishing, extra margin space is not needed. Whatever 
margin width you choose, keep it consistent in all sections of your manuscript. As noted 
below, page numbers may (and should) sit below the bottom text margin, in the page footer.

•	 All content (including text, figures, tables, etc.) should fit within the margins, although pages 
may be rotated to landscape orientation to accommodate wide figures, tables, etc., and wide 
content may extend slightly into the left and right margins.

https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/format_changes_2021.pdf
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Pagination and page numbering

•	 All pages except the title page should have a visible page number.

•	 Because your electronically published manuscript, unlike a printed book, will not have left 
and right facing pages, position your page numbering at the bottom center of each page for 
symmetry, below the 1"–1.25" margin but at least .5"–.75" from bottom edge of the page.

•	 Front matter (defined in 3. Detailed Formatting Guidelines below) page numbers may be 
lowercase Roman numerals (“i,” “ii,” “iii,” etc.) if you prefer traditional book-style pagination. 
As an alternative, you may start with Arabic page number 1 on the title page and continue 
sequential page numbering throughout your manuscript.

•	 Your title page will be Roman-numbered page “i,” or Arabic-numbered page “1” (depending 
on which numbering convention you choose) but should not have a visible page number on 
it. The first page of your abstract — with the first visible page number — is Roman-numbered 
page ii or Arabic-numbered page 2, and so on. If you go with Roman-numbered front matter, 
the first page of the body of your paper — introduction or first chapter/section — should be 
Arabic-numbered page 1. See the Quick tip on how to restart page numbering.

•	 All page numbers in your body text and back matter (defined below) must be Arabic numerals 
(“1,” “2,” etc.) continued from the previous chapter of your paper. Please do not start each 
new chapter with page 1. Do not start back matter (references, appendices) with a new page 
numbering scheme; instead, continue from the last page 
of the last chapter.

Main text

•	 Body text should be double-spaced (see note below). 
Spacing around subheadings, block quotes and other 
text elements may vary, but should be sufficient to make 
these elements readily identifiable and different than 
body text.

•	 Basic text should be between 10–12-point size in a 
commonly used text font such as Arial, Calibri, Helvetica, 
Times New Roman, Garamond, Verdana, etc. Do not use 
script, informal typefaces, or display fonts for basic text elements.

•	 It’s up to you and your committee whether to set your main text justified (with even left/right 
margins) or flush-left/ragged-right (aligned left with uneven right margin), and whether or 
not to allow end-of-line hyphenation of words.

Note: The double-space requirement is for the main text specifically. Some other text elements 
will look and fit better single-spaced, or with spacing less than two full lines. Title page text, table 
of contents, subheadings, block quotes, captions, tables, and equations are good examples. Some 
elements in your front and back matter — the title page, table of contents, lists of figures/tables, and 
references, for example — are more manageable when single-spaced with a line space or so between 
elements.

Best practices

CONSISTENCY is the key to 
good ETD formatting! Your main 
chapter headings, subheadings, 
basic text styles, captions, 
element alignment, and other 
formatting choices should be 
CONSISTENT throughout your 
manuscript.
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Indentations and headings

•	 The first line of each paragraph should have a left indent, or you should insert an extra line 
space (double space) between paragraphs. There is no need to do both.

•	 First-level headings (title, abstract, table of contents, chapter titles, etc) must be formatted 
to stand out more than any other level of headings. We suggest (but do not require) that you 
use ALL CAPS for your first-level headings, unless those headings contain lots of acronyms, 
scientific names, or chemical formulas that require both upper- and lower-case letters for 
clarity. If you are following a discipline-specific style guide, you may use the heading style 
preferences you are accustomed to.

Note: If your manuscript consists of multiple journal articles — or journal styles — slight differences 
in formatting from article to article are acceptable, but your main text must be single‑column with 
1"–1.25" margins and use consistent fonts throughout. It is not acceptable to simply insert the PDF of 
a previously published journal article, formatted specifically for that article, into your ETD. You may, 
however, include an article with original formatting as an appendix or as an additional file upload.

3.	 Detailed formatting guidelines — your manuscript section 
by section

PDF examples of standard manuscript elements (title page, front matter, body, and back matter) are 
available on the Graduate School’s Templates, Links & Tools webpage.

Front matter

The front matter of your manuscript includes all major sections from the title page to the first body-
text chapter. A PDF sample file for front matter is available linked at Templates, Links & Tools.

Title page (required)

The title page is the first official page of your manuscript (page “i” or page “1”). If you use the title 
page template provided by the Graduate School, you may not need the title page information 
below. If you elect not to use the Times New Roman font family 
for your manuscript, be sure to change the fonts in the title 
page template to the fonts you use in your manuscript. The 
title page should be formatted as follows:

•	 Page margins must be set to between 1 and 1.25 inches.

•	 A page number should not be visible on this page, but is 
acceptable.

•	 Text should be centered horizontally between the margins.

•	 Each section of text should be single-spaced with a 
double space between sections.

•	 Horizontal divider rules of equal width and line weight 
should separate each block of text, and the spacing above 
and below each divider line should be consistent.

download

https://www.clemson.edu/graduate/students/theses-and-dissertations/forms-links-tools.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/forms-links-tools.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/Title-page-template-2019.docx
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/Title-page-template-2019.docx
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/Title-page-template-2019.docx
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/Title-page-template-2019.docx
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• Your paper’s title should be in ALL CAPS. Italicize any scientific nomenclature (i.e., genus
and/or species names) or titles of other works that appear in your title, and follow standard
scientific nomenclature rules regarding capitalization where all-caps is confusing or
inappropriate.

• If your title consists of more than one line of text, break the lines in a logical and attractive
way, so that the lines are approximately the same length.

• The layout and wording style of your title page must match the sample title page, including
line breaks within text sections.

The title page Word template is also linked at Templates, Links & Tools .
A TigerPrints cover page, populated with your metadata, will be generated automatically when 

your ETD is archived .

Abstract (required)

The abstract is a succinct statement of the significant contents of your manuscript and the value 
and relevance of your research . Generally, brevity is good . An abstract should be no longer than 
350 words; however, it may be longer if absolutely necessary . Your abstract page should begin on 
Roman-numbered page ii or Arabic-numbered page 2 . Include a general abstract as the second 
page even if your ETD consists of journal articles with individual abstracts.

Dedication (optional)

If you include one, your dedication pays special tribute to people who have given you extra ordinary 
support or encouragement in your academic career . Extravagant praise, insincere thanks, and 
references to inanimate objects are considered unprofessional; please avoid these . The dedication 
should be brief — one page or shorter .

Acknowledgments (optional)

If you choose to include acknowledgments, these remarks thank those who have helped you 
obtain your graduate degree, including those who have given grants and special funding for 
research . Acknowledgments may also include permission you’ve obtained to quote copyrighted 
material . Extravagant praise, insincere thanks, and references to animals or inanimate objects are 
unacceptable .

Table of contents (required)

The table of contents aids the reader in navigating the manuscript and should be arranged 
according to the structure, or order of matter, of the document . In an electronic manuscript, each 
content entry may be linked to its opening page in your text . The table of contents must meet the 
following formatting requirements, whether you use Word’s automated table of contents tools or 
build your table manually:

• Headings must be identical in wording to those in the body of the document.

• Every entry must have a corresponding page number.

https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/example_front-3.pdf
https://www.clemson.edu/graduate/students/theses-and-dissertations/forms-links-tools.html
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•	 Major sections (first-level headings like chapter and unit titles) must be included. Also 
include major subheadings within each chapter. Lower-level subheadings may be included, 
but they are not required.

•	 Single-spacing of table of contents entries with an extra line space between chapters or 
sections is acceptable, and desirable if your table of contents runs long.

•	 Alignment, indentation, and spacing of entries must be consistent.

•	 The page number for each entry must be right-justified at the right margin.

Ellipses (rows of leader dots) must be inserted between each entry and its corresponding page 
number. The ellipses should not be created with individually-typed periods. Follow the 
ellipses instruction “cheat sheet” to create indents and ellipses for your table of contents.
Note: The Graduate School does not require that you include working links in your table of contents 
entries.

Using Word’s automatic Table of Contents tools

If you plan to use Word’s table of contents tools (found under the References tab > Table of 
Contents > Automatic Table of Contents), you will need to apply heading styles from the Word 
styles menu to your front matter titles, chapter titles and top level of subheadings (use the 
Heading 1 and Heading 2 paragraph styles). Inserting an automatic table of contents will 
introduce paragraph styles named TOC 1, TOC 2. etc., into your style menu, and you may 
customize these styles to use the same font family as your in-text headings. 
	 Microsoft hosts instructions for how to Insert a Table of Contents, and there are useful 
video tutorials available online, including How to Create and Update a Table of Contents in 
Microsoft Word hosted on YouTube from ErinWrightWriting.com.

Be aware that when you make edits — additions, deletions, or size changes — to text or graphic 
elements in the body of your paper, you may cause pages to reflow; that is, elements may move 
from one page to another. Whether you’ve prepared the table of contents manually or used the 

Quick tip

Can’t get those dots in your table of contents 
and lists of tables and figures to line up? 
Many writers find a manually created table of 
contents is the most complex (and annoying) 
portion of a manuscript to format correctly. 
Please check out the ellipses instruction 
“cheat sheet” for tips on formatting your 
table of contents — this instructional PDF 
includes how to create evenly spaced leader 
dots using tabs, good line spacing, and 
uniform indents.

https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/Ellipses%20Instructions_final.pdf
https://support.microsoft.com/en-us/office/insert-a-table-of-contents-882e8564-0edb-435e-84b5-1d8552ccf0c0
https://youtu.be/LK49aGK63_E
https://youtu.be/LK49aGK63_E
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/Ellipses%20Instructions_final.pdf
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/Ellipses%20Instructions_final.pdf
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automation feature, reflow may leave the page numbering of your contents entries inaccurate. It’s 
always a good idea to re-check your table of contents page numbers against the actual page each 
entry appears on for accuracy, and to update as needed, as a last step once all of your editing and 
revision is complete. If you use Word’s automated table of contents, update either the entry page 
numbering or the entire table after you finish all other editing.

Lists of tables, figures, maps, etc. (required if your ETD contains these 
elements)

You should include a list of tables, figures, maps, abbreviations, 
or other similar items when there are three or more tables, 
figures, or similar items in your manuscript. Each type of list 
should begin on a separate page unless all of the lists will fit on 
one page. Tables and figures included in the appendices should 
also be included in the content lists. All lists must meet the 
following formatting requirements:

•	 �Titles and entries must be identical in wording to their 
counterparts in the body of the document, unless 
captions are many sentences long. In this case, an 
abridged caption may serve as an entry.

•	 �Every entry must have a corresponding page number.

•	 �Ellipses (rows of leader dots) must be inserted between each entry and its corresponding page 
number. Get the ellipses instruction “cheat sheet” to help you manually create these.

•	 �Each list should be formatted consistently with the main table of contents — to whatever 
degree is practical.

Using Word’s automatic Table of Figures tools 

As with the table of contents, Word has automated Table of Figures tools under the References 
tab. Using these tools requires using the Caption tool for your captions or legends. You can use 
the tools for both tables and figures, and can customize the appearance of your lists. Check out 
Microsoft’s support article, Insert a Table of Figures, or search for a how-to video online, such 
as these related tutorials from ErinWrightWriting.com on YouTube: How to Create and Update 
a List of Tables or Figures in Microsoft Word, and How to Insert Figure Captions and Table 
Titles in Microsoft Word.

Body (main text)

The body of your manuscript includes all of your chapters or sections. The body may be formatted 
in any accepted, discipline-specific style or according to an approved style guide, but with the 
following restrictions:

•	 Text of the body of your paper may begin on Arabic-numbered page 1 if you used Roman 
numbering for your front matter, or may continue from the front matter numbering if you are 
using Arabic numerals throughout.

Quick tip

If you choose to number the 
tables or figures in your body text 
by chapter (e.g., 1.1, 1.2, 2.1, 
3.1, etc.), then to distinguish 
appendix figures/tables from 
those in the body of your paper, 
use a naming scheme such as 
“A.1, A.2, B.1, C.1” etc.

https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/Ellipses%20Instructions_final.pdf
https://support.microsoft.com/en-us/office/insert-a-table-of-figures-c5ea59c5-487c-4fb2-bd48-e34dd57f0ec1
https://youtu.be/z6NP31Q1w3M
https://youtu.be/z6NP31Q1w3M
https://youtu.be/MpoE6CCadlw
https://youtu.be/MpoE6CCadlw
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•	 Body text must be single-column and 
double-spaced.

•	 First-level headings (chapter and/or section 
titles) must be consistent in style — font, 
weight, size, case, placement relative to text — 
with the first-level headings in the front matter.

•	 Each individual level of heading/subheading 
should have a separate and distinct — but 
consistent — format that demonstrates relative 
importance (for example, first-level headings 
should appear more prominent than second-
level headings, and so on).

•	 Spacing around headings, tables, figures 
and other elements should be consistent 
throughout the manuscript.

Note: if chapters or sections of your ETD have been 
previously published as journal articles, and those 
journals require or prefer that you maintain their 
formatting, then variations in style between chapters 
is acceptable.

A PDF sample file for body text is available at 
Templates, Links & Tools.

Back matter

The back matter of your manuscript includes the 
appendix or appendices, endnotes (if needed), 
and reference section(s). If you choose not to place 
figures and/or tables within each chapter, those 
can be grouped in their own back matter sections. 
Notes may be combined with references, or set as 
footnotes or end-of-chapter notes, depending upon 
which annotation style is appropriate for your field 
of research. It’s OK to have references at the end of 
one or more chapters and a general reference section 
at the end. Order your back matter sections by your 
advisor’s preference. A sample back matter PDF file is 
available at Templates, Links & Tools.

Appendix or appendices

An appendix presents information that is too detailed for the body text or is supplemental or 
indirectly related to the text, such as tables, figures, research authorization forms, and computer 
programs/code. If you have several categories of supplementary material, you may include 

Hot link

How to restart page numbering if you are 
following traditional book pagination: 
In Word, to restart your page numbering 
with page 1 (and switch from Roman to 
Arabic numbering), you will need to insert 
a section break (from the Layout tab or 
the Insert main menu) after the last line on 
your last page of front matter. Then scroll 
your document to your Introduction/Ch. 1 
opener. Go to the Insert tab; select Page 
Number > Format Page Numbers from the 
dropdown menu, then at the bottom of the 
popup window you may enter the new start 
page as 1.

Best practices

This is not a requirement, but a suggestion. 
For best appearance and readability, 
subheadings should be followed by two 
or more lines of text (i.e., they should not 
sit alone at the bottom of the page.) If you 
are using Word styles, you can specify this 
in a subheading paragraph style in the 
menu by selecting Modify Style > Format 
> Paragraph > Line and Page Breaks and 
selecting these options:

https://www.clemson.edu/graduate/students/theses-and-dissertations/forms-links-tools.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/forms-links-tools.html
https://support.microsoft.com/en-us/office/add-different-page-numbers-or-number-formats-to-different-sections-bb4da2bd-1597-4b0c-9e91-620615ed8c05
https://support.microsoft.com/en-us/office/add-different-page-numbers-or-number-formats-to-different-sections-bb4da2bd-1597-4b0c-9e91-620615ed8c05
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more than one appendix, grouped together as the 
“appendices.” Each appendix in the appendices 
section should have a descriptive title.

When your manuscript contains more than one 
appendix, you should name each and begin each 
on a new page. Option: You may, if you choose, 
separate your appendix section from the body of your 
manuscript with a divider page. The divider page 
goes only between the body and the first appendix, 
not between appendices. It should contain only the 
word APPENDICES — centered horizontally and 
vertically on the page, in the same style (typeface, 
case, and size) as your first-level headings — and 
the page number, in the same position as other page 
numbering. The first appendix will start on the next 
page. Note that the use of a divider page is now 
optional, not required.

Bibliography, literature/works cited, or references

The writing style guide preferred in your discipline will dictate whether you use a bibliography, 
a literature or works cited section, and/or a references section. The format you use should be the 
same as is required in the major journals in your discipline. Your chosen style guide will help you 
determine whether references should be numbered, alphabetized, set with space between entries, 
or with a “hanging” indent for continuing lines of long entries. A good style guide will also help 
you be consistent in using such elements as full names or initials, abbreviations, dates and page 
numbers, punctuation, and italics or quotation marks for titles and publications. If you are not 
sure about which format to use, consult your advisor. You must adhere to the following standard 
requirements when formatting your bibliography, literature/works cited, or references section:

•	 Single-line spacing is fine in your references, as long as you use numbering, indents, or 
space between each reference entry to set them apart.

•	 If you are following traditional book style, links/hyperlinks (URLs and email addresses) 
should not be blue or underlined. You can edit the default hyperlink style in Word’s styles 
menu by right-clicking on that style and choosing Modify > Font, then changing color to black 
and unchecking underline. Leaving your links colored blue and underlined is acceptable for 
electronic publishing. Whichever style you choose, please maintain consistency throughout 
your manuscript.

•	 Your reference section(s) may be included either at the end of the manuscript (following or 
preceding the appendices) or at the end of each chapter, but you should be consistent when 
possible.

Best practices

Ideally, individual reference entries should 
not be split across pages. If an entire entry 
does not fit at the bottom of one page, 
move the entire entry to the top of the next 
page. If you are using Word styles, you 
can customize the References paragraph 
style in the menu by selecting Modify Style 
> Format > Paragraph > Line and Page 
Breaks and turning on Keep lines together 
under the Pagination tab.
	 Note that Manuscript Review will not 
request that you revise your reference 
section(s) if you do split reference entries 
across pages.
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4.	Additional formatting-related information
Please take note of the following details regarding special formatting requirements, your 
responsibilities as a student, and copyright law. Additional information about formatting assistance 
is also provided below.

The GS7 form (GS7M or GS7D) — record of your committee’s approval

Following Clemson University’s transition from print to electronic thesis and dissertation 
submission, a formal approval (or signature) page is no longer required as part of your manuscript. 
Your completed and committee-signed GS7M or GS7D form will serve this purpose. You can 
download the GS7M or GS7D from the Forms & Applications page at the Graduate School website. 
Be sure to select the correct form for your degree level: GS7M for master’s candidates, or GS7D for 
doctoral candidates. After completing this form and obtaining 
the necessary signatures of all of your committee members, 
return the form electronically or as a printed copy to Enrolled 
Student Services. This form should not be included as a page 
in your manuscript. Check the graduation deadlines for 
deadlines related to submitting this and other forms.

Formatting alternatives for LaTeX users, 
programs in architecture, visual arts, 
communications, creative writing 

You may use the open-source document formatting program 
LaTeX for your thesis or dissertation, but all pages leading up 
to the first page of the body must be formatted as described in 
these instructions. The Graduate School’s LaTeX template package contains both the style sheet 
and a complete example of what your manuscript should look like. We strongly suggest that LaTeX 
users download this template package. If you need assistance with using or modifying the template, 
check with fellow users in your department or visit TeX - LaTeX Stack Exchange, an online user 
community forum for LaTeX support.

Several School of Architecture graduate programs have their own preferred formatting for 
ETDs, and may require you to use Adobe InDesign for laying out your manuscript. If you are an 
architecture student, contact your advisor for information on your program’s specific format 
requirements.

Communications, creative writing and visual arts manuscripts should adhere to the basic guides 
outlined above regarding margins, fonts, title page, contents, etc., and to the rest of the formatting 
requirements to the extent that the subject matter/nature of your ETD allows. Electronic publishing 
enables you to submit as additional files many types of material that simply don’t fit within the 
confines of the 8.5" x 11" PDF text page, as the following section details.

Additional files (spreadsheets, databases, video, audio files, etc.)

If you choose to include computer code, a database, a PowerPoint presentation, an audio or 
video file, oversized CAD drawings or other graphic elements, or any type of digital information 
that cannot be converted into PDF, or that will not fit into or be compatible with the standard 
manuscript page size (8.5" x 11"), you may upload these files as additional files during your 

Hot link

If you’re a coding enthusiast 
and your program recommends 
LaTeX for formatting, download 
the Graduate School’s LaTeX 
template package for a format-
compliant template. For help 
using or customizing it, consult 
fellow users in your department.

https://www.clemson.edu/graduate/files/pdfs/GS7M.pdf
https://www.clemson.edu/graduate/files/pdfs/GS7D.pdf
https://www.clemson.edu/graduate/students/forms.html
https://www.clemson.edu/graduate/students/deadlines.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/thesisTemplate.zip
https://tex.stackexchange.com/
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/thesisTemplate.zip
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/thesisTemplate.zip
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manuscript upload process. These files may be in any digital format, just as they would be if you 
were including a computer disk in a bound copy of a manuscript. When readers access your thesis or 
dissertation online, they will see links to these files. Copyright permissions documents received 
from providers of your source materials may be uploaded as additional files if you don’t include 
them within your manuscript (see below).

Variations from these format guidelines

We cannot anticipate every possible format option a student may consider, so there may be a 
format or method you would like to use that is not discussed here. If you’re in doubt, contact the 
Manuscript Review office at manuscriptreview-l@clemson.edu before investing a great deal of 
time in a particular format that you’re not sure will be accepted. While the Graduate School is the 
final authority on formatting and publication issues, in light of evolving technology and expanding 
definitions of thesis and dissertation work, we do yield to graduate program directors’ or advisors’ 
preferences.

Copyright held by others . . . or by you

Make sure you have permission to reproduce materials to which someone else owns the copyright. 
Obtain a letter of consent or permission from the copyright owner before you use materials taken 
from any original publication. This may include getting permission to reproduce your own content 
(writing or research) that has been previously published. Materials that may require a letter of 
consent include figures (illustrations, diagrams, photographs), maps, tables, and the text of poems, 
songs, etc. You can include permission letters (scanned, if necessary) in the appendices of your 
manuscript, or you may upload permissions documents as additional files as described above; these 
will be archived with your ETD.

If you are citing your own previously published works or those pending publication, use the 
same citation style and reference entry/entries as you do with works by others. You need not cite 
unpublished papers.

Information about obtaining copyrights for journal content is generally available on a journal’s 
information-for-authors or editorial information webpage. Check with the Clemson Libraries’ 
subject librarian in your field for information on other types of copyrighted material.

5.	 Items to remember, summarized
Plagiarism statement

Before submitting your manuscript, please read this reminder about plagiarism. Plagiarism 
includes the accidental or unintentional representation of another’s words or ideas as your own, as 
well as intentional misrepresentation of the origin of work, so take this important last step to ensure 
that you have avoided identifying another person’s work as your own. The University Libraries 
offer a self-enroll Canvas training on Avoiding Plagiarism for Graduate Students. Also, use the 
Turnitin® tool described below in section 6.

mailto:manuscriptreview-l%40clemson.edu?subject=Alternative%20formatting%20for%20my%20ETD
https://libraries.clemson.edu/research/subject-librarians/
https://www.clemson.edu/graduate/students/theses-and-dissertations/plagiarism.html
https://clemson.instructure.com/enroll/PLWJBC
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Final checklist

Before you submit your manuscript, please refer to the final ETD checklist to ensure that your 
formatting adheres as closely as possible to the requirements. Following the Checklist will help you 
avoid many of the formatting pitfalls that necessitate revisions. Also see Theses & Dissertations: 
FAQs for more information.

Templates available

If you are using Microsoft Word, a formatting template is available for your convenience. To edit 
the template, you will need to save it to your hard drive, open it in Word, and save it with a new 
filename. We also provide a template solely for the title page, and a template for LaTeX users. To 
see all the Graduate School’s available templates, check out the Templates, Links & Tools webpage.

Samples available

In addition to templates, a sample manuscript with helpful notes is also available as a PDF for your 
reference. You’ll find descriptions and links to several sample files at Templates, Links & Tools.

If any you have specific formatting questions that are not addressed within this guide, please 
email the Manuscript Review office at manuscriptreview-l@clemson.edu.

6.	 Optional: Check your citations 
with Turnitin® before you 
submit your ETD

The team members of GRAD 360°, the Graduate 
School’s comprehensive and inclusive professional 
development program, invite you to make use of 
Turnitin® via Canvas.

Please note that, although implemented through 
Canvas, this is an invitation, not a required course. No 
grades are given, and you won’t get feedback from the 
Graduate School.

How do I access and use Turnitin®?

The current semester’s course, GRAD 360° Turnitin® for Grad Students, appears in Clemson’s 
Canvas All Courses catalog and is set up for self-enrollment. While it is available for anyone with 
a Clemson University login, the course was designed specifically for graduate students enrolled in 
research credits while working on a thesis or dissertation. The instructor, a non-faculty GRAD 360° 
team member, is unable to assist non-graduate-student users in navigating the course.

Once you’ve enrolled, check the Information & Instructions page in the course, or download 
the info as a PDF from course files. The course now contains ten identical assignments (submission 
opportunities); this permits multiple file submissions as well as resubmission by overwriting a 
previous upload.

Hot link

Canvas “course” GRAD 360° Turnitin® 
for Grad Students. To locate the current 
semester’s course in Canvas, use the link 
above or go to Courses > All Courses > 
Browse More Courses > Enter grad 360 
in the search field to locate the current 
semester’s course in the University’s 
public course catalog.

https://www.clemson.edu/graduate/files/pdfs/Checklist_final.pdf
https://www.clemson.edu/graduate/students/theses-and-dissertations/revise.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/FAQs.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/FAQs.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/gs_manuscript_template.docx
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/Title-page-template-2019.docx
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/thesisTemplate.zip
https://www.clemson.edu/graduate/students/theses-and-dissertations/forms-links-tools.html
https://www.clemson.edu/graduate/students/theses-and-dissertations/manuscript-files/Example%20Manuscript_5-18-07_SAM-3.pdf
https://www.clemson.edu/graduate/students/theses-and-dissertations/forms-links-tools.html
mailto:manuscriptreview-l%40clemson.edu?subject=Manuscript%20formatting%20question
https://grad360.sites.clemson.edu/
https://clemson.instructure.com/search/all_courses?search=grad+360
https://clemson.instructure.com/search/all_courses?search=grad+360
https://clemson.instructure.com/search/all_courses?search=grad+360
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Please note that this opportunity to use Turnitin® is not a substitute for submitting your 
electronic thesis or dissertation (ETD) for format review and publication. That’s an entirely different 
process, described previously in this guide.

What exactly is Turnitin® and how will it help me?

Turnitin® is a plagiarism-prevention software app licensed for 
use by the University community under Clemson’s institutional license, and is enabled through 
Canvas. Many faculty members use Turnitin® to review student work. For the individual student 
researcher, Turnitin® facilitates best practices for using and citing other people’s written work. 
When you access the program and upload all or part of your thesis or dissertation, the Turnitin® tool 
compares your file’s text to an extensive scholarly database and student paper archive of published 
material to determine if text in your paper matches text in any of the Turnitin® databases. Matching 
or very similar text highlighted by the tool indicates that you’ll need to cite your original source(s) 
if you have not already done so. The tool generates a similarity score that shows what percentage of 
your document is similar in text content to other existing works.

Don’t be dismayed by a similarity score that seems high to you, and please don’t commit yourself 
to an endless, stressful cycle of rewriting, resubmitting and rechecking to try to get that score as 
close as possible to 0% — especially if this causes you to miss key deadlines. For the independent 
user, Turnitin® is primarily a useful tool for identifying and double-checking your citations. Good 
research in any field interprets, builds and expands upon previous research, so 0% similarity is not 
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